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Please note

We have produced this Guide for use at the Genetics Department’s cluster of 
Macintosh computers. 

Unless you are using these machines as part of a supervised practical you need 
to register with Dr. Alistair Chambers to be able to use them

Although the tutorial presumes you are using a Genetics Macintosh, you can use it elsewhere, 
because the TeachText application (used in Part 4) is available on all Macintoshes.

There is an on-line tutorial, supplied with all Macintoshes, and available on the Genetics 
Macintoshes, called Macintosh Basics.  Double-clicking the picture for this program on the 
screen will start the tutorial. It is an excellent simple introduction to the Macintosh.  You may 
like to try that tutorial after you've worked through this Guide, or, indeed, instead of this Guide.

There is much more to learn about using the Macintosh, but we are sure that you will find it 
fairly easy: the Macintosh encourages you to try things out, and the more you learn, the more 
confident you get.

3



The Genetics Macintoshes
To use the Genetics Macintoshes you must register for this cluster 
of computers.   If you are a student you must see Dr. Alistair 
Chambers in the Gentics Department (lab. D3) to register.  Every 
time you use one of these computers you must fill in the log book 
beside the computer.  Each computer is labelled on the keyboard 
with its number, be sure to enter your usage into the correct log 
book.

Code of Conduct
Usage of these computers implies you have agreed to the code of 
conduct.  Anyone breaking this code may be banned from using this
facility.  Brief points to mention here are:
1. These computers are provided for use related to your course 

only.  They are not for preparing personal letters etc.
2. No software may be installed an any computer without prior 

permission of Dr. Chambers.
3. No software may be copied from these computers without prior 

permission of Dr. Chambers and permission will only be given 
if copyright allows.
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Welcome to the Apple Macintosh!
The Macintosh's operating system has always been completely integrated with 
its hardware. The Mac user almost never has those intimidating encounters 
with strange parts of the system which can trouble the PC user. The Mac either 
works, or it doesn't; usually it works – wonderfully!

The Macintosh screen is intended to resemble a desktop upon which you can 
lay out your work folders, which in turn you can open up so that they cover the
desktop. (Microsoft's Windows environment for MSDOS is now rather like the 
Apple interface, and “windows” or “desktop” environments are being produced
for other types of computer.)

But remember, the Macintosh is not an IBM PC-compatible, it uses a completely 
different operating system and therefore will not run PC software.  However, 
data from PC (DOS) diskettes can be transferred to the Macintosh, please see 
Alistair Chambers or Fergus Doherty (Biochemistry) if you need to do this.  Do 
not put PC formatted diskettes into the Macintoshes without supervision as you
may loose valuable data.

Using applications
“Applications” are programs that “apply the technology” of the computer to 
perform various functions, such as word processing, drawing, graphing, etc. 

One of the great things about the Macintosh is that all programs behave in the 
same way – once you have learned how to use one application, you can guess 
how to use almost any other, at least at a basic level.

In addition, the operating system allows you to exchange text and data between
applications as though they were one, and such tasks as printing are extremely 
easy.
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Macintosh hardware

On/Off switch

The On/Off switch on a Mac Classic/Classic II (which is what the Genetics 
machines are) is at the back of the computer unit, on the left hand side as you 
face the front of the unit, just above where the power cable enters the 
computer. 

Normally you don’t just switch off a Macintosh: you tell it to ‘shut down’ and 
then switch off (more later). However occasionally the system may freeze, and 
you may need to switch it off and then on again in order to restart it. (See also 
Reset button, next).

Reset and Interrupt buttons

Many departmental or personally-owned Macintoshes have two buttons fitted 
to the side of the computer unit, called the Reset and the Interrupt switches. 
You can press Reset to restart the computer without using the on/off switch 
(you will normally lose the work you were doing at the time). These buttons 
are fitted to the Genetics machines and are on the left-hand side of the case 
towards the back.  Press the button nearest you only if the computer freeezes 
(does not respond to the keyboard or the mouse).

Brightness and contrast controls

Adjust the brightness control to the lowest setting you find comfortable.  With 
the Mac Classic this is done with a software ‘Control Panel’.  You will deal 
with this later in the guide but you should set the brightness to the lowest you 
are comfortable with.

Internal floppy disk drive

Accessed through a slot on the front panel of the machine, this mechanical 
device reads data from and writes data to 31⁄2" disks (still often called “floppy 
disks”, though the case is rigid). Most Macintosh 31⁄2" disk drives now use 
1.44mb high density disks, which can equally well use 800kb double density 
disks. Many Macintoshes can also read and write PC DOS disks (but see 
above). 

Internal hard disk

Hard disks can hold vast amounts of information (typically 50 to 200 times the 
amount on a high density disk).  The speed of access is also much faster.
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Disk drives can break down.  Also, software problems can occasionally occur 
and make some or all of the data stored on a hard disk inaccessible.  For these 
reasons, it is very important that you keep secondary (i.e. “backup”) copies of 
your essential documents on 31⁄2" disks.

You will not store your own documents on the hard disks of the Genetics Macs,
which are public access machines, although you may be able to do this 
temporarily during practical classes.

Keyboard
A Macintosh has a standard computer keyboard, plus two extra keys which are 
used to produce different characters, or to issue menu commands. These are 
marked Option and , and we will be describing their use later.⌘

Mouse
With any computer, you need some way to tell the system what you want to do.
With the Macintosh, this has always been done by pointing at things on the 
screen, or selecting items from menus, using the mouse – as you'll discover 
shortly.
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Tutorial Part One: Using the Mouse
Part 1 shows how to use the mouse to move around – and move things around 
on – the desktop. 

Pointing

Slide the mouse around the mouse mat (or tabletop) and you will notice the 
pointer move the same way on the Mac screen.  The mouse works by rolling a 
rubber covered ball against rollers inside the casing.  It is very important to 
keep the mouse mat (or table top) clean: a dirty or dusty mouse becomes 
difficult to use.

The pointer changes shape, depending on the situation: When you select 
objects or menu items, it looks like a small arrowhead.  When you edit text, it 
looks like a long capital I, called an I-beam (see the Glossary).  The different 
pointers improve ease of use in each situation. 

When you're waiting for the Macintosh to complete an operation, the pointer 
changes to a wristwatch: you can't do anything while this is displayed.

Pointers often have an active portion: on the standard arrowhead it is the tip of 
the arrow.

Lifting the mouse

If you run out of room to move the mouse – for example you reach the top of 
the mouse mat – lift it and put it down where you have more room – for 
example at the bottom of the mouse mat.

8



Clicking
Pressing the mouse button and releasing it quickly is called clicking. A single 
click is used to select objects.

Exercise: clicking to select an object
1. Move the mouse so the pointer is pointing at the wastebasket - 

2. Click the mouse button.

3. Move the pointer to the hard disk’s icon, 

4. Click the mouse button.

Each time you click you see the object darken, showing that it is “selected”.

Dragging
You can use the mouse to “drag” an object across the screen – for example in 
order to put the object inside another object. Dragging consists of pointing at 
the object, then pressing and holding down the mouse button, then moving the 
mouse. As you move the mouse, the pointer moves and drags an outline of the 
icon (see the Glossary) and its title along with it. When you release the mouse 
button, the icon snaps to its new place.

Exercise: dragging an object
1. Move the pointer to the Wastebasket.

2. Drag the Wastebasket to another position on the desktop, but avoid any open 
windows.

3. Repeat steps 1 and 2 to move the hard drive icon.

4. Finally, drag the icons back to their original position.
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Double-clicking
Double-clicking means to point at an object or icon and click the mouse button 
twice in rapid succession. Double-click whenever you want to open an object –
for example when you want to open a document, open an application program 
such as Works, or open a disk or folder to view its contents. (Double-clicking 
has other uses as well, such as selecting a whole word when editing text.)

Exercise: double-clicking an object to open it
1. Point at the Wastebasket icon and double-click. A window opens which displays

the current contents of the Wastebasket. You have just “opened” the 
Wastebasket icon.

2. If the machine you 're using is being looked after properly, there shouldn't 
actually be anything in the Wastebasket at this time, and so the window will be 
empty and the words “0 items” appear in the top left hand corner of the window.

(Actually you very rarely open the Wastebasket: we're using it because it's the simplest object 
to use for this exercise.)

Summary on using the mouse
Remember three things when using the Macintosh mouse:
1. Select  an object with a single click of the mouse button. You must select 

an object before you can do anything to it except open it …
2. Open  an object with a double click of the mouse. Disks, folders, and 

applications (such as Microsoft Word) are common things that you open.
3. Drag  (move) a selected object or objects by holding the mouse button 

down while moving it across the mouse mat (or table). Dragging is also 
used to select a range of items, such as a section of text in a document. 

Important!
Have patience! Sometimes when you press the mouse button you may not get 
an immediate response. Avoid the temptation to click on the button repeatedly. 
The Mac remembers each button press, so you could set off an unexpected 
chain of repeated actions. 
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Tutorial Part Two: Macintosh windows
different elements you'll see on a desktop which has open windows. The 
desktop is controlled by a program called the Finder, which oversees all 
operations; more about the Finder in Parts 3 and 4.

Menu bar A window Dimmed icons

Active window Close box

Title bar

Selected
icon

Scroll bars

Size box

Zoom box

Menu bar

Described in Part 3.

Window

Displays, using icons (see Glossary), the contents of a folder, which is itself 
represented by an icon. Any folder can contain other folders, which in turn can 
contain other folders, etc.
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Active window
The one which you're working in at present – there's an exercise at the end of 
this part of the Guide which explains this further.

Dimmed icon
Indicates that the icon has been opened into a window. Look at your 
Wastebasket icon:  you will see that instead of being shaded as before, it is now
“empty” and grey, indicating that it is open on the desktop. 

Title bar
The title bar is at the top of the active window. The name or title of the icon is 
displayed in the centre of the title bar. To move a window, drag it by its title 
bar.

Exercise: using the title bar to drag a window 
1. Point at the title bar of the Wastebasket window.

2. Drag the window to another position on the desktop.

Close box
The small grey square at the upper left hand corner of the window is the close 
box, which is used to close – or “put away” – the active window.

Exercise: using the close box
1. Point at the close box of the Wastebasket window.

2. Click the mouse button (the window will disappear back into the Wastebasket 
icon).

3. Now reopen the Wastebasket icon (by double-clicking it).

Zoom box
The grey square at the upper right hand corner of the window is the zoom box, 
which is used to resize the window. The first click opens it to the best size to 
display all its contents; a second click restores it to the previous size. 

Exercise: using the zoom box to resize a window
1. Point at the zoom box of the Wastebasket window.

2. Click the mouse button (the window will shrink to the minimum size – there's 
nothing in this folder at present).

3. Click in the zoom box again (the window will go back to its original size).
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Size box
The grey square at the lower right hand corner of the window is the size box, 
which is used to resize the window to whatever shape you desire.

Exercise: using the size box to resize a window
1. Point at the size box of the Wastebasket window.

2. Drag towards the lower right of the screen to make the window different sizes. 

Using the size box to change their shape, and the title bars to change their 
position, you can fit windows on the screen in the way that suits you best. It 
doesn't matter if they overlap, because you can bring any window to the front 
of the “pile” simply by clicking in it.

Scroll bar
When a window is too small to show everything, you can use the scroll bars to 
move the contents into view. There is a vertical and a horizontal scroll bar, each
of which has three active parts:

1. Scroll arrows : click on an arrow to move the contents of the window up or
down one line at a time, or left or right one column at a time. The action is 
repeated at speed if you hold down the mouse button.

2. Main part of the bar : a single click in the bar will move the contents of 
the window up, down, right or left by a screenful. The action is repeated at
speed if you hold down the mouse button.

3. Scroll button : drag this up and down the bar to move to any position in 
one step.

We can't practise scrolling yet because the Wastebasket window is empty, and 
so the scroll bars aren't active.

Activating windows
You can't do things in a window unless it is active. You can have many open 
windows, but only one active window.

Activate a window by clicking anywhere inside it, or double-clicking its 
dimmed icon (which you would do if the window itself was obscured). The 
selected window will move to the top of (overlay) all the other windows and its
title bar will become active.
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Exercise: making a window active
1. Click on the hard disk icon – notice that the Wastebasket window's title bar 

goes blank.

2. Now click anywhere inside the Wastebasket window – notice that the title bar 
regains its lines and its boxes, indicating that the window is again active.

3. Finally, close the Wastebasket window.
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Tutorial Part Three : Using Menus

Along the top of the Macintosh screen (desktop) there is always a menu bar. 
This is a key element in the consistency of using a Macintosh computer. The 
first three items on the menu bar will always be the Apple ( ) menu, the File 
menu, and the Edit menu, no matter what program you run. The menus to the 
right of the Edit menu will vary depending on the application.

At the extreme right you will always see the “balloon” icon, and the icon for 
the program which is currently active. Using balloons gives you instant 
explanatory help in many Macintosh applications (the icon itself explains this). 
The Active Application icon presents a list of currently open applications 
(programs), and you can use this to move swiftly between those programs. The 
section below explains how to use menus.

As we said at the start of Part 2, whenever you start up the Macintosh you will 
be in the Finder, which controls the desktop. The menus that appear in the 
Finder are: , File, Edit, View, Label and Special.
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 (“Apple” menu)

• Move your mouse pointer to the Apple symbol in the extreme top left of 
your screen.

• Click on the Apple, and have a brief look at the menu before releasing it.
• Now read what follows, looking at the Apple menu when you feel like it.

About this Macintosh....

Alarm Clock
Calculator
Chooser
Control Panels
Key Caps
Microsoft Works
Note Pad
Puzzle
Scrapbook

The Apple menu provides access to two important things:
1. An About… menu displays information about the current application.
2. A list of “Desk Accessories” (DAs) and other programs. The standard DAs

supplied with the Macintosh  provide quick access to a range of functions, 
described below. Other DAs can be added by Macintosh owners.

In addition to the DAs, the Macintosh owner or administrator can add entries 
for standard applications, so that it is easier to open them up – rather like the 
table d'hôte menu in a restaurant!

About…
This menu item displays information about the current application such as its 
version number. If you're not in an application but just in the Finder, it displays
the amount of memory in total, in use, and available, and other things.

Exercise: using the Apple menu
1. Click on the Apple, and drag the pointer down to About… 

2. Note that About… is highlighted: release the Mouse button
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3. Because you're currently in the Finder, you'll see some information about  this 
Macintosh. It's a little technical and may not be of much interest to you at this 
stage.

4. Close the About… box by clicking on its close box. 

Desk Accessories

The standard desk accessories supplied with the Macintosh System Software 
are: Alarm Clock, Calculator, Chooser, Control Panels, Key Caps, Note Pad, 
Puzzle, and Scrapbook. The Macintosh User’s Guide has details about using 
the DAs, but most are easy to work out. Brief descriptions follow.

Alarm Clock
When you choose Alarm Clock, a small digital clock displays the hour, minute,
and second. You can also use it to sound a beep at a certain time.

Calculator
The Calculator is like a very simple ordinary calculator; it's best to use the 
numeric keypad (on the right of the keyboard) to operate it, rather than the 
mouse.

Chooser
The Chooser is used to select which network facilities, such as file servers or 
printers, you wish to use.

Note: on the Genetics Macintoshes it is not possible to change all the Chooser 
items, because of the way they have to be set up for use.

Control Panels
Control Panels are used to adjust many system settings, from such things as 
speaker volume and mouse speed, to things like memory control. Control panel
settings are saved, so any changes you make will remain in effect. We ask that 
you do not make any permanent changes to the Genetics Macintoshes: it can 
confuse users who follow you, and wastes staff time in discovering what's 
wrong and then putting it right.
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Key Caps
The Key Caps DA is useful for finding special symbols that are 
not printed on the keys of your Macintosh keyboard. When you open 
Key Caps, it displays a picture of your keyboard and places a new item on your
menu bar called Key Caps. From the Key Caps menu, select the font you want 
to use and then press Option, Shift, or Option-Shift to see what characters are 
available when holding down those keys.

You can either type the character you want or click on it in the picture of the 
keyboard. Characters typed in Key Caps can be edited, copied, then pasted into
your document.

Note Pad
With the Note Pad, you can jot down a few notes and keep them separate from 
the document you’re working on. You may also type text and edit it even if 
you’re using an application that doesn’t allow text editing in the usual way. Of 
course, you can Cut and Paste your notes for use in any other application (see 
Edit Menu, later).

You have numbered pages of Note Pad paper. Turn to the next page by clicking
the turned-back corner of the previous page. Turn to the previous page by 
clicking on the bottom left corner of the Note Pad screen.

On the Genetics Macintoshes the Note Pad isn't so useful because you can't 
really keep what you type – anyone using the computer after you might discard
it.

Puzzle
Just an amusement. Try it sometime – it's a good mouse exercise.

Scrapbook
The Scrapbook is a place to keep frequently used text and pictures, and 
provides a method to copy text and graphics from one application to another. 
To put something in the scrapbook, first copy what you want, open the 
Scrapbook, then paste the item into it (see the Edit menu, later). Use the 
reverse procedure to copy something from the Scrapbook into your document. 
Use the scroll bars to look through the Scrapbook.

On the Genetics Macintoshes the Scrapbook isn't so useful because you can't 
really keep what you put in there – anyone using the computer after you might 
discard it.
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Applications
Interspersed among the DAs, you will see names of application programs. 
These have been put there by the system administrator, and provide an easy 
way of opening these programs.
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File menu

New Folder N⌘
Open O⌘
Print P⌘
Close Window W⌘
Get Info I⌘
Sharing...
Duplicate D⌘
Make Alias
Put Away
Find... F⌘
Find Again G⌘
Page Setup...
Print window...

The commands in the File menu operate on icons and windows. Notice that 
some of the commands are dimmed. Dimmed commands are not available until
something else is done – usually selecting an object first.

Notice also the “keyboard shortcuts” – for example N. These mean that if ⌘
you press the Command key (marked  on every Apple keyboard) together ⌘
with the indicated letter, that action will be carried out. Keyboard shortcuts are 
amazingly useful when you're a bit more experienced.

We're currently looking at the Finder's File menu. Every application program's 
File menu is similar, with differences appropriate to the application.

In what follows, don't try any of these things out!   You will get a chance to use
them, when appropriate, shortly.

New Folder
Creates a new folder called “untitled”. You should immediately rename a new 
folder to reflect its future contents.
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Open
Used to open objects such as folders and applications. Since this is the same as 
double-clicking on an object, this menu item is almost never used from the 
Finder; however it's used all the time from the File menu of application 
programs.

Print
If you select a document and then select Print, the application that was used to 
create the document will be opened and the file sent to the printer. In practice 
this command isn't used much because you normally already have the 
application open.

Close Window
Used to close the active window. This is the same as clicking on the close box 
in the upper left corner of the window.

Get Info
Displays information in an Info box about the currently selected icon. This is 
very useful for finding out version numbers, creation dates, document kind, 
and the size (in bytes) of a file. The  Info box also lets you change a couple of 
important attributes:
1. The Locked check box can be clicked on or off. A locked file cannot be 

changed or deleted.
2. Every program is allocated a fixed amount of memory when it runs. 

Sometimes, to work on a large document or graphic, you will need to 
increase the amount of memory allocated to the application. This can be 
done in the Info box.

Sharing
There are extensive file sharing facilities for users of Macintosh networks. This
topic is not covered in the Guide.

Duplicate
Makes a copy of the selected file or folder. The duplicate copy is automatically 
named “filename copy” where filename is the name of the original file or 
folder.
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Make alias
This command creates a tiny file which is named “filename alias” (where 
filename is the currently selected filed or folder). The alias is simply a pointer 
to the real file (which could even be on another disk). You can then move the 
alias to another folder (or menu), thus making it easily possible to open the 
original from the other location. Naturally, you can repeat this. So for example 
you might have a folder containing all your documents, and you can put aliases
for it into every other folder which might want to access it – those containing 
word processors, graphics packages, etc.  The administrator has created aliases 
for applications you will need and placed these in the folders set up by each 
department.

Put Away
If you have moved an icon to the desktop (the grey background area) selecting 
Put Away will put the icon back to where it came from. This is also an easy 
way to move things back out of the Wastebasket.

Find…
Helps you find files on any disk. It is very handy to use when you can 
remember at least part of the name of a file, but don’t know where it is on your 
system. You can be very specific about the file names by asking for “More 
choices”.

Find again
Looks for the next file whose name fits the description  you gave when you  
last used Find.

Page Setup…
Opens the page setup window for the currently selected printer (printers are 
selected using the Chooser). This lets you choose such options as paper size, 
orientation, etc.

Print Window
Prints out the contents of the currently selected window in the same format as 
displayed on the screen.
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Edit menu
The Edit menu is important because it provides a method of copying and 
pasting information from one part of a document to another, and from one 
document to another document (even if these documents are created by 
different applications).

Undo Z⌘
Cut X⌘
Copy C⌘
Paste V⌘
Clear
Select all A⌘
Show clipboard

The commands are Cut, Copy, and Paste. These commands make use of a 
special file in the System Folder called the Clipboard. The Clipboard can only 
hold one item at a time, but that item can be anything from a single character to
an entire document including text and graphics.

The functions in the Edit menu vary a little from one application to another. In 
the Finder, the functions of the Edit menu apply mainly to editing icon names 
and Get Info information.

In the Finder, clicking on an icon not only selects the icon, but also selects the 
text of its name. When this text is selected, the functions of the Edit menu 
become active. If you click in this text, the pointer changes to a text editing 
insertion point.

Undo
Undoes your last text editing action.

Cut
Removes the currently selected text and places it on the Clipboard (replacing 
whatever is currently on the Clipboard).

Copy
Copies the currently selected text and places it on the Clipboard (replacing 
whatever is currently on the Clipboard).
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Paste
Puts a copy of the Clipboard contents at the insertion point. You can continue 
to paste copies of the Clipboard at the same point or anywhere else – it is kept 
until replaced.

Clear
Removes the selection without placing it on the Clipboard. This is the same as 
pressing the  Delete key (top right of main keyboard).

Select All
Selects all icons in the active window. This is handy when you wish to copy, 
delete or move a lot of files.

Show Clipboard
Opens a window showing the current Clipboard contents (i.e. the last item you 
cut or copied).

View menu
The View menu lets you change the way you look at the contents of a directory
window. The standard view you have looked at thus far is called the icon view. 
For windows containing applications, this view is usually preferred, because 
the large distinctive icons make it easy to choose the program you want. For 
windows containing documents, view by Name, Date, Size, or Kind is usually 
preferred. View by Small Icon has its fans, but it is not really of much use.

by Small Icon
Displays the directory contents with a small icon that lets you see more files in 
the window than the Icon view, but the icons are far less distinct.

by Icon
Displays the directory contents with large distinct icons (this is the default 
view).

by Name
Alphabetically by name.
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by Size
By file size, largest to smallest.

by Kind
By kind – documents are separated from applications and each kind of 
document is grouped together.

by Label
From “hottest” to “coolest” – see Label menu, next.

by Date
Chronologically by the date last modified. Files are listed in newest to oldest 
order.

Label Menu
You can assign a colour and category to a selected item by using this menu. 
This feature is useful for Macintosh owners with very large numbers of files 
and folders. 
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Special menu
This menu contains functions that don’t fit in the categories of the other menus.

Clean Up Window
Icons can be placed anywhere in a window, but it is desirable to have them all 
aligned horizontally and vertically. For this purpose, windows in the Finder 
have an invisible grid for icon alignment. Clean Up Window moves all icons to
their nearest grid location.

Empty Wastebasket
When an icon is placed in the Wastebasket, the file is not immediately 
removed. Emptying the Wastebasket forces the Finder to delete all files placed 
there. 

Even when you select this item, the Macintosh will ask you first if you want to 
delete these files! This double security can become tedious; but if you hold 
down the Option key while opening the menu and selecting Empty 
Wastebasket, you will not be asked to confirm the deletion of files. You may 
prefer this technique when you really know what you're doing.

Eject Disk
Ejects the currently selected floppy disk, but leaves its icon on the desktop. 
This is useful when you need to copy from one diskette to another on a one 
floppy drive system.

The usual method of ejecting a disk is to drag the icon of the diskette to the 
Wastebasket. (Despite the drastic implication, this does not affect the files on 
the disk in any way whatever!)

Erase Disk
Initializes (i.e. “formats”) the disk whose icon is selected. The Macintosh 
reminds you that this process erases any current contents of the disk. 
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Restart
Choose this menu item if you wish to restart your machine. You may want to 
do this if the system seems to be acting erratically. Restart takes about half a 
minute on most Macintoshes.

On Genetics Macintoshes:
It's a good idea to do this as soon as you sit down at a public Macintosh: the 
previous user may have left the system in a mess, and restarting should clear 
this up.

Shut Down
Choose this item whenever you want to turn off your Macintosh: it ensures that
all open applications and files are closed properly, and then “parks” the hard 
disk. Avoid just switching the power off – doing so increases the chance of files
getting corrupted and causing the system to malfunction.
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Tutorial Part Four : Using folders and files
This part of the tutorial gets busy: be prepared to concentrate!

The Finder is the part of the Macintosh's operating system which provides the 
user interface. In other words, it looks after the “desktop” on the Mac screen. 
In doing so, it manages your files, and manages the applications (programs) 
which you're using.

Whenever you open an application program, such as Microsoft Works, you 
leave the Finder and enter that application. When you quit the application, you 
go back to the Finder. You can have several applications loaded at once, and 
you can switch from one to another very quickly. 

It's time to start doing things with files, so you will need something to practise 
with. We'll create a couple of folders and a few files to move about in them.

Floppy disks

You are going to save your work on your own floppy disk. You may be given a 
floppy disk that has already been prepared for use on the Macintosh.  Insert 
into the disk drive at the right hand side at the front of the Macintosh with the 
the label uppermost and the metal guard pointing at the computer.  As you push
the drive mechanism will take the disk in.

If the disk has been formatted (initialized) for the Macintosh its icon will 
appear on the right of the desktop:  

If the disk has not been initialized the following message will appear:
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The above message will appear if you are using a Double density (DD) disk 
which can hold 800kb when used in a Macintosh. Click on ‘Two-sided’ to 
make use of the full 800kb. If you are using a High Density (HD, 1.44Mb) disk
this choice is not offered and the following will appear:

This gives you the option to continue and initialize the disk, or abandon the 
process. Click the initialize button to continue.  The following warning then 
appears:

A second chance to abandon the process.  Any data on the disk e.g. an MS-
DOS disk, will be lost. Click the erase button to continue.

Now you are prompted to give the disk a name. Unlike MS-DOS computers 
you have great freedom to choose a meaningful name which can have 32 
characters (letters and numbers) and can include spaces:

Just type the name into the box, for now call it ‘My Disk’. If you make a 
mistake typing press the delete key (top right of main keyboard) to remove the 
incorrect characters and re-type. Click ‘OK’ when you are ready.
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The computer will display messages on the progress of the initialization. It may
fail if the disk is faulty, in which case a message wil appear to that effect and 
the disk will be ejected. When initialization is complete the disk icon will 
appear on the desktop (see above) and the disk is ready for use.

Make a Practice folder

Folders are used on the Macintosh to keep files organized and grouped 
together. Just as you would not throw all your papers into a file cabinet drawer 
without folders to keep everything organized, you don't keep all your computer
files in one single folder. 

(By the way, on other computers folders are known as directories and 
subdirectories.)

Exercise: creating a new folder
1. Make sure that the floppy disk window is open and is the active window. If it's 

not, double-click on the floppy disk icon to open the window, which will now be 
active.

3. Choose New Folder from the File menu.

An icon for a new folder appears: note that it is called “untitled folder”

4. Type the word   ‘Practice’ and then press the Return key – note that this is how 
you name a newly created folder.

Using keyboard shortcuts
• Now open Practice by double-clicking on it. New folders and files will go 

into this, the active folder.

Exercise: Using the keyboard shortcut to create a folder
1. Make another new folder , this time by using the keyboard shortcut:  ⌘N:press

down the ⌘⌘key and tap the  N key once 

Another new folder icon appears; it is highlighted and its name is “untitled 
folder”. 

2. Type in a name for this new folder: type the name

Exercise

then press the Return key.

This “trick” – using ⌘N – is called a keyboard shortcut: you see these listed in
Menus, indicating that you can use the key combination instead of opening the 
menu and selecting the item required. 
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As we've said elsewhere, these are extremely useful, once you know what 
you're doing.
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Renaming folders
If you want to rename a folder you must place the pointer in the right place…

Exercise: editing a file or folder name
1. First click the mouse anywhere inside the active window Practice. (This is only 

to make sure, for the purposes of this exercise, that you de-select the folder 
you've just created.)

2. Now click the mouse pointer on the name of your new folder Exercise.

Notice that the name is highlighted in a black box with a white border again. 
When the pointer is inside this box, it changes to an I-beam, indicating that 
you're working with text.

3. Type a new name  ‘My Basket’ then press the Return key.

Note that Macintosh file or folder names can be up to 32 characters long, and 
can contain almost any characters, including spaces.

You can edit file or folder names like any other text on a Macintosh, so that 
(for example) you can click the mouse inside the name and insert or delete 
characters as necessary. It takes practice to be accurate in this tiny space.

Exercise: create yet another new folder
• Can you remember how to create a new folder? 

Create another new folder inside the Practice folder, and call it “Your basket”

Refer to the previous page, Using the keyboard shortcut, for a reminder.

Finally:

• Click the Close box  in the Practice window – your active window should now 
be  My Disk’, click the close box of the  ‘My Disk’ window to close it.

Creating documents
Although we're about to create a couple of text documents, in fact any file on 
the Macintosh which is not a program is usually called a document (programs 
are usually called applications).

You will use the TeachText applocation to create and save a document. Double-
click on the Macintosh HD icon in the top left of the desktop. This opens the 
hard disk window. Double-click on the Biochemistry folder to open it. You 
should see the TeachText icon in the window of the Biochemistry folder. It 
looks like this:
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• If you can't see the icon, change the size of the window, or use the scroll 
bars, until you can see it.

TeachText is the simplest possible word processing program. It comes with 
every Macintosh, so that there is always the ability to display text files. We're 
using TeachText now because it's very basic – normally you would use a full 
word processing application to create text documents.

Exercise: opening an application and creating and saving a 
new document

1.  Double-click on the TeachText icon – the program will start up, and you will 
notice the Menu bar change.  In the right hand corner of the menu bar you will 
see a small version of the TeachText icon to show that TeachText is the active 
application  (you can have more than one application open at once on the 
Macintosh).

2. The screen is mostly filled by a blank window which has the name Untitled – 
this is a new document.

3. Start typing the names of a few enzymes you know (well we had to choose 
something!): type 

Lysozyme then press the Return key; then type
Ribonuclease then press the Return key;

Type a few more (if you want).

4. Move the mouse pointer to the ‘File’ menu’ and hold the button down over the 
word  ‘File’. The menu should pop-down. Holding the mouse button down drag 
down the list of commands to ‘Save as...”.  You will notice that as you go down 
the list of commands each one in turn will be highlighted.  When ‘Save as..’ is 
highlighted release the mouse button.

5. A dialog box will appear:
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 Type the name of the document ‘Enzymes’ which will replace ‘Untitled’.

6. Now you have to tell the computer where to save this document. You want to 
save it in the folder ‘My Basket’ which is in the ‘Practice’ folder on your floppy 
disk ‘My disk’.  The name at the top of the scrolling list is ‘Applications’.  If you 
were to save now the document would go into this folder.  So how do we 
navigate to the right folder so that it’s name appears at the top of the list. Click 
on the button ‘Desktop’ 

7. The following  should now appear:
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 By clicking on desktop we move to the topmost level of the organisation of 
disks, folders and files and we can see the floppy disk ‘My Disk’ in the list.box  
Double-click on ‘My Disk’ and it should appear above the list box and the folder 
‘Practice’ in the list box.  Double-click on ‘Practice’ in the list box and it will 
appear above the list  box which will show ‘My Basket’ and ‘Your Basket’.  
Finally double-click on ‘My Basket’ which will appear above the list box, which is
empty as there are no files or folders in  ‘My Basket’’

8. Finally, click on the ‘Save’ button and your document will be saved as 
‘Enzymes’ to the folder ‘My Basket’.

The dialogue box disappears from the screen.  Click in the close box of the 
document window and it will disappear.  If you had closed the document 
window without first saving then you would have been prompted to save and 
name the document before it is closed. Closing a document without saving will
lose the data.

Create another document
TeachText is still in charge, and its menu and icon are at the top of the screen. 
Now open the File menu, and choose New.  This time type the names of some 
carbohydrates into the document – 

Glucose  (press the Return key)
Lactose (press the Return key)
Sucrose

– then close the document by clicking in the close box and save it when 
prompted as ‘Carbohydrates’ in your ‘My Basket’ folder. Refer back to the 
previous section for a reminder if you need it.

Quitting the application
Now leave TeachText:

1. Move the mouse pointer to the File Menu.

2. Press and hold down the mouse button; drag the pointer down to Quit; release 
the mouse button.

You may have noticed that the keyboard shortcut for Quit is Q, which is ⌘
handy to know. 

You leave almost every Macintosh application by choosing Quit (or using 
Q).⌘
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Open your Practice folder
You have now returned to the desktop. Close any open windows by clicking in 
the close boxes (tip: if you hold down the option key as you click in the close 
box of one window all the windows will close). Now open your folder 
‘Practice’ by double-clicking the floppy disk icon and when the window is 
open double-clicking on the ‘Practice’ folder icon. Continue to open the ‘My 
Basket’ icon. In it you should see your two new files ‘Enzymes’ and 
‘Carbohydrates’.

You may wish to play with the size box and the zoom box at this point.

Moving files
To move a file from one place to another, drag it there. Try moving the file 
‘Enzymes’ into the folder ‘Your Basket’:

1.  Click on your document ‘Enzymes’.

2. Hold down the mouse button, and drag ‘Enzymes’  to  ‘Your Basket’.

When  ‘Your Basket’ darkens, to show that it is selected, release the mouse 
button. You may have to move the ‘My Basket’ window in order to see ‘Your 
Basket’ icon.

3. The document disappears into that folder.

4. Double-click on  ‘Your Basket’s icon and you'll see  ‘Enzymes’ in there. 

5. Now close  ‘Your Basket ‘ again by clicking the close box.

The same applies when moving files anywhere in the Mac: drag the file's icon 
to the location you're moving it to, that icon will darken, and you can release 
the mouse button.

However if you drag an icon to a folder on another disk (for example the 
floppy disk drive), the file is not moved but copied – a convenience which 
leaves the original copy intact.

Copying files
There are three ways to duplicate a file:
1. You can choose Duplicate from  the File menu.
2. Or you can select the file and use the keyboard shortcut.
3. Or, if you want to make a copy in another folder, you can use a special 

trick.

We'll do (2) and (3) here:
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Exercise: A quick way to duplicate a file
1. Click in the ‘My Basket’ window to make it active and bring it to the front. Select 

the Carbohydrates icon.
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2. Press down the Command  key – that marked  ⌘and while pressing it, tap the 
letter D. A new file appears called  ‘Carbohydrates copy’

Exercise: How to duplicate a file into another folder
1. Press down the key marked Option.

2. Hold down the Option key while you select and then drag the file icon for 
‘Carbohydrates’ (not ‘Carbohydrates copy’) to the folder ‘Your Basket.’ 

Release the mouse button when Your basket is highlighted, and then release the
Option key.

3. Now open  ‘Your Basket ‘– you'll see a copy of ‘Carbohydrates’ has been put in 
there, while the original remains in the main folder. (The new file is not called 
‘Carbohydrates copy ‘because it's the only file called  ‘Carbohydrates’ in the 
folder ‘Your Basket’.)

4. Close ‘Your Basket’’ again.

The two special keys you've just used – the Command  key and the Option ⌘
key – are used frequently on the Macintosh to modify the behaviour of mouse 
and keyboard actions.

Deleting files
Your active window should be ‘My Basket’, click on it to bring to the front.

Exercise: using the wastebasket
1. Make yet another copy of ‘Carbohydrates’:

• Select the file ‘Carbohydrates’

• use  D ⌘ to duplicate it.

• Notice what this new copy has been called!

2. Now is a good time to tidy the window: Select Clean Up Window from the 
Special menu, then click the Zoom Box of your ‘My Basket’ window.

3. Drag the icon of the new file  to the Wastebasket. You may have to move the 
open window to see the wastebasket icon. When the file is over the 
wastebasket the wastebasket will be highlighted.  Release the mouse button 
and the file will be dropped into the wastebasket.

Notice how the Wastebasket bulges to show that there's something in there! If 
you change your mind about deleting the item(s) you put there, you can open 
the Wastebasket and move the item(s) back out.

The Wastebasket isn't emptied until you specifically request it (we'll do this 
later). Only a really bad system error will empty the waste basket – normally 
even switching off the Mac will not empty it.
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Viewing the contents of folders
Select the View menu and select the options in turn, noting the different ways 
in which the files are listed within the active window; click the Zoom Box 
when necessary. Each of these options is useful in different circumstances, 
although in this case you will not see much difference in some views – there 
are so few files in this folder, they're all tiny, and they were all created just 
now.

More Hot Tips
Here are a few more exercises which introduce some helpful features in file 
handling. There are no specific objectives in what follows – the purpose is 
demonstration.

1. From the Views menu, select by Name.

You will notice that a  small triangle appears beside each folder name.

2. Click on the triangle for each folder ‘My Basket’ and ‘Your Basket’.

Notice that the triangle points downward, and that the contents of each folder 
are listed. This is an easy way to see what's in folders without actually opening 
them.

Click in the triangles again to close the lists.

3. Open the folder ‘Your Basket ‘ and move the file ‘Enzymes’ out into  ‘My Basket 
window– you may have to move the window to do this. (Move a window by 
dragging its title bar, remember?)

4. Go to ‘Your Basket’ window and move the file ‘Carbohydrates’ into the ‘My 
Basket‘.

The Finder asks you

An item named  ‘Carbohydrates’ already exists in this location … ?

Click the OK box.

5. Close ‘Your Basket ‘.

6. OPen ‘My Basket’. Click on the file ‘Enzymes in ‘My Basket.’

7. Now press and hold down the Shift key while you click on the file  
‘Carbohydrates’

If you've done this successfully, both items are now highlighted.

8. Now drag ‘Enzymes’ to the Wastebasket – ‘Carbohydrates’ goes with it, 
because it is also selected.

You can select as many items as you wish in this way, so long as the Shift key 
is held down.
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9. Retrieve these files from the wastebasket.  Double-click to open the 
wastebasket and shift-click to  select both files and drag them back to  ‘My 
Basket’.

10. Position the mouse pointer to the left of the document ‘Carbohydrates’. Now 
drag the mouse down and very slightly to the right – you will see a box of dotted
lines (a “marquee”) open up, and any item which the box touches becomes 
selected. 

Release the mouse button when you've selected all items in the folder.

What if you have accidentally included files you don't want in this multi-
selection? 

10. Press the Shift key and click ‘Carbohydrates’ – that file is now de-selected from
the group.

11. Now click anywhere in the window – all items are de-selected.

12. Now press the  ⌘ key and A – you may remember that this is a keyboard 
shortcut from the Edit menu which means “Select all”. 

13. Click anywhere in the window again in order to de-select all the items.

14. Close the ‘My Basket’ window.

15. Drag  the folder ‘My Basket’ to the Wastebasket.

16. Close the ‘Practice’ and ‘My Disk’ window.

17. Choose Empty Wastebasket from the Special menu, and click on OK to finally 
delete the files there — you've finished.

Control Panels

Brightness control

To change the screen brightness go to the Apple menu, click on the  and drag
down to Control Panels. The control panel will open and you should see the Brightness 
control panel. Double-click on the icon and a slide-bar appears. Click on the slider and drag it 
to set the desired brightness. Click the close box and finallt close the control panel window. Do
not interfere with any other control panels.

Glossary of basic Macintosh terms
We hope you've found this tutorial useful and enjoyable. Let us know if you 
can suggest improvements.

Here are a few Macintosh terms which will further improve your knowledge.
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application ––The computer’s tools for performing tasks. A set of instructions 
the computer executes. Also called a “program” or “software”. For 
example, MacPaint is a graphics application; Microsoft Word is a word 
processing application.

byte––The amount of memory taken up by one character. A character includes 
a letter, number or symbol, even something invisible like a carriage return.
(kilobyte, megabyte)

click––To place the pointer over an icon or text and quickly press the mouse 
button once. (double-click, drag, select)

Clipboard––A place in RAM, or if large enough, on the system disk, where 
the Macintosh temporarily holds cut or copied information. Each item cut 
or copied to the Clipboard replaces the previous item – the Clipboard can 
only hold one item at a time. The Clipboard allows easy transfer of 
graphics or text between programs or documents. (RAM, Scrapbook)

desktop––The Macintosh screen, including the grey area and the menu bar 
across the top of the screen. The icons that are on your desktop represent 
what is available for you to work with. (Finder)

document––The term for anything that you create on a Macintosh, sometimes 
called “files”. Documents can contain graphics, text, spreadsheets, or a 
combination. You can name, edit, delete, merge, duplicate, reformat, copy 
and print documents. 

double-click––To place the pointer over something and click the mouse button
twice in rapid succession. The technique used for selecting and opening. 
(click, dragging)

drag––To place the pointer over something, click and hold the mouse button, 
then move (drag) the mouse and release––click-hold-drag-stop-release. 
The technique used to move an icon, select text or choose commands from
menus. (click, select)

Finder––A special application, always on the desktop, that you use to organize
documents, start other applications and move information to and from 
disks. (desktop)

folder––A place to organize and neatly store documents on the desktop 
(similar to a folder in a file cabinet or a sub-directory in MS-DOS or 
Unix).

I-beam—The mouse pointer used by Macintosh applications to indicate that 
text is being edited. It varies slightly from  one program to another. It 
normally looks like this: 

icon––The graphic – and hopefully informative – representation of a disk, 
document, application, folder or other information.  
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initialize––Until it's initialized, a disk is just a piece of plastic coated with 
ferric oxide. Also called formatting, this process maps out sectors of the 
disk for the computer's software. Formatting a disk erases any information 
currently held on it – a fact which the Macintosh does not let you forget 
when you start the formatting procedure.
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kilobyte (K)––A unit of measurement. One kilobyte is 1,024 bytes. For 
example, 800K equals 819,200 bytes or characters, which is approximately
400 double-spaced pages. (byte, megabyte)

marquee—A dynamic rectangle, controlled by your dragging the mouse 
pointer, used to select an area of the screen display. It's usually defined by 
a dotted line:  (drag)

megabyte (MB)––A unit of measurement. One megabyte is 1,024 kilobytes or 
1,048,576 bytes. High density 31⁄2" disks for Macintoshes hold 1.44mb of 
data. (byte, kilobyte)

menu––A list of commands from which you can choose different operations. 
(drag)

mouse––The device you move across your desktop or work surface. The 
pointer on the screen corresponds with the mouse movement. You can 
move the mouse to select objects, icons or execute commands. (click, 
double-click, dragging)

pointer––A small figure on the screen that corresponds with the movement of 
the mouse. The pointer is most often an arrow when you are pointing at 
things like icons or menus, but it can turn into several different shapes 
depending on what you are doing. For example, it becomes an I-beam 
when you are working with text you can edit, or a wristwatch when the 
Macintosh is doing something that takes a little time. (mouse)

RAM––(Random-Access Memory). The part of the Macintosh memory that 
exists only while the computer is on–once you turn the computer off, 
anything in the RAM is gone forever. Everything you create on the 
computer is temporarily located in RAM until you specifically save it on a 
disk. RAM can hold both your own work and application programs. 
(Clipboard, ROM)

ROM––(Read-Only Memory). Contains information the computer uses to start
itself. ROM is permanent information and does not disappear when you 
turn the computer off. (RAM, System file, system software)

Scrapbook––A desk accessory where you can save frequently used text and 
graphics. The Scrapbook can store multiple pieces of information while 
the Clipboard only holds one at a time. (Clipboard)

scroll bar––A thin rectangular bar along the right edge (vertical scroll bar) or 
bottom edge (horizontal scroll bar) of a window. Clicking or dragging in 
the scroll bar allows you to search through windows for information that is
not immediately visible. (window)

select––The technique used to indicate where the next action will take place. 
Click or drag across information to select it. (click, drag)
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startup disk––A disk that contains the system files the computer uses to start 
itself. A startup disk must contain a Finder and a System file. Other 
possible files include the Scrapbook, Clipboard and printer information 
(e.g., ImageWriter, LaserWriter). The icon of the startup disk is always in 
the upper-right corner of the desktop.

System file––A file the computer uses to get itself started or to provide system-
wide information. (ROM, system software)
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system software––The set of files in the System Folder that the Macintosh 
uses to run itself, no matter what application you are using. (ROM, startup 
disk, System file)

Wastebasket— The desktop icon where you place documents, folders, and 
applications that you no longer need or want. On American Macintoshes 
this is called the Trash, and documentation often uses the American verb 
“to trash” an item.

window––The area on your desktop through which you view information. For 
example, the contents of a disk, folder or document are viewed through a 
window. (scroll bar)

Reproduced from “Macintosh Basic Skills Lecture”, University of Michigan Computer Center.
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